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SAR Management Computer Software Intro

Please:
Sit in teams of two.
Start laptop. Connect to power supply.
Collect CD.
Insert CD in drive. If it does not autostart, open Windows
Explorer, change to CD drive, and run
“Install-Run-Help.exe”.
Highlight the program you want to install, and press
“Install”. Always select default location as Destination
Folder, and always create a shortcut on the Desktop.
Do this for all programs.
Return CD.

Thank you.
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Introductions

Please introduce yourselves by giving
Your name.
The name of your SAR Unit.
The location of your SAR Unit.
The years of experience you have in SAR Management.

Thanks.
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Installed Software

KwikNote, Version 0.19.
Win C.A.S.I.E. III, Version 0.67.
SAR T-Cards, Version 0.18.
Clue Manager, Version 0.08.

On your Desktop:
ExercisesKwikNote.pdf.
ExercisesWC3.pdf.
ExercisesSARTCards.pdf.
SettlerSARGroundTeam.stc.

The software comes with a money-back guarantee.
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Outline

Approximate Topic
Time (mins)

15 Introduction and load software
10 KwikNote
10 SARAZ.ORG
90 Using Win C.A.S.I.E. III During A Hasty Search
10 Break
90 SAR T-Cards

We will demo a piece of software with you playing along, then
hand out assignments for you to do as a team. We will move
from one team to the next to give hands-on help.
We won’t have time to show Clue Manager, which tracks clues,
but it is easy to understand and use, if you read the Help file.
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Hooray!

No quizzes or tests.
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KwikNote

KwikNote is a program that allows you to create notes while
working on other projects. It is designed to replace the pencil
and pad frequently found beside computers for jotting down
reminder notes.

Initially written for SAR personnel, but has since found many
other uses.
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KwikNote

When you run KwikNote, its icon appears in the bottom
right-hand part of the screen (the System Tray).

If you right-click on this icon, you have two choices:

Show KwikNote
Exit KwikNote
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KwikNote

Selecting Show KwikNote brings up the main application.

If this is the first time using KwikNote, select the menu item
Startup.
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KwikNote

Startup All starts KwikNote for all users when the
computers starts up.
Startup User starts KwikNote for only the current user
when the computers starts up.
No Startup stops KwikNote from starting up when the
computers starts up.
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KwikNote

It is obvious how to use KwikNote, but if you have any
questions, look in Help Topics under the Help menu item.
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?

Any questions?
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KwikNote

Now do the assignment described on Outline Card 2 of
ExercisesKwikNote.pdf, namely:

Open KwikNote and Add A New Note called “SARAZ”. In the
note enter:

WWW.SARAZ.ORG
The mission of SARAZ.ORG is to promote land
search-and-rescue professionalism and education by facilitating
the exchange of information among land SAR practitioners.
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SARAZ.ORG

WWW.SARAZ.ORG is a website designed to promote land
search-and-rescue professionalism and education by facilitating
the exchange of information among land SAR practitioners.

Created by Aaron Dick, Eric Johnson, and David Lovelock in
July 2009.

When your computer is connected to the web, you can use your
previous KwikNote entry to copy the name of the website into
your browser.
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Homepage of SARAZ.ORG

The blue menu items are accessible to the public.
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SARAZ.ORG

What Is New? summarizes the changes in the website.

Calendar brings up a Google calendar with dates associated with appropriate
local entries (workshops, conferences, meetings, etc.).

Conferences/Training brings up a list of conferences and training workshops.

Documents brings up a list of SAR-related documents.

Presentations brings up a list of documents presented at various conferences,
such as MRA and NASAR. The slides from this session will be available here.

Strange But True is where unexpected outcomes to SAR operations are
documented.

FAQs brings up a list of questions about the website.

Free Software brings up a list of free software, some SAR specific and some of
general use.

External Links brings up a list of SAR specific links.

Volunteer Groups is a list of the AZ SAR Volunteer Groups.

Contact Us allows the user to send an email to SARAZ.ORG@gmail.com.
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SARAZ.ORG

If you are an AZ SAR Coordinator, and would like access to that
section of the website, please fill in the form and we will email
you with details.
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?

Any questions?
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What is Win C.A.S.I.E. III?

C.A.S.I.E. stands for Computer Aided Search Information
Exchange.
It is a search manager’s toolkit.
Software originally written about 30 years ago for
programmable TI calculator, then Commodore 64, then
DOS, and now for Windows XP (called Win C.A.S.I.E. III).
C.A.S.I.E has been used successfully in many large-scale
searches in Australia, Canada, Israel, New Zealand, UK,
USA, etc.
Originally written to help in large-scale searches.
The windows version, Win C.A.S.I.E. III, has been
expanded for use in both hasty and large-scale searches.
There is a smooth transition from one to the other.
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Win C.A.S.I.E. III and Hasty Searches

During a hasty search it can be used to
Access and print1 many search management forms, such
as ICS forms, Lost Person Questionnaire, Urgency Rating
Chart, Clue Report, Clue Log . . . .
Import other forms and download forms from NIMS.2

Provide summaries of lost person behavior from NASAR’s
MLPI manual.
Complete an Urgency Rating Chart.
Keep a complete record of planning decisions and actions
using an Initial Note. Can include IAP, subject details,
urgency rating chart, resources used, resources
requested, ICS structure, LPB, subject found details, . . . .

1Printer required.
2Internet required.
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Win C.A.S.I.E. III

Win C.A.S.I.E. III really stands out in large-scale searches, but
they don’t occur very often.

So in this session we are going to introduce you to those parts
of Win C.A.S.I.E. III that can be used in a hasty search.

We offer 8-hour, hands-on workshops on the full capabilities of
Win C.A.S.I.E. III during both a hasty and a large-scale search.
These workshops are restricted to 12 people, and require a
knowledge of POA, POD, ROW, as taught in an MLPI-type
class.

There is no cost for these workshops, but we expect expenses
to be covered.
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Win C.A.S.I.E. III Opening Window

Open Win C.A.S.I.E. III (by clicking its icon on the Desktop),
and follow along.
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Win C.A.S.I.E. III Main Menu

Note, you can always get help in Help Topics under the Help
menu item.

During a hasty search we use the Initial Resources menu item.
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Win C.A.S.I.E. III Main Menu

Note, you can always get help in Help Topics under the Help
menu item.

During a hasty search we use the Initial Resources menu item.
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Win C.A.S.I.E. III Initial Resources menu

We are going to concentrate on Access Forms, Urgency Rating
Chart, Lost Person Behavior, Lost Person Behavior Distance
Traveled, Circular Search Areas, and Initial Note. Select
“Access Forms”.
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Win C.A.S.I.E. III Initial Resources menu

We are going to concentrate on Access Forms, Urgency Rating
Chart, Lost Person Behavior, Lost Person Behavior Distance
Traveled, Circular Search Areas, and Initial Note.

Select
“Access Forms”.
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Win C.A.S.I.E. III Initial Resources menu

We are going to concentrate on Access Forms, Urgency Rating
Chart, Lost Person Behavior, Lost Person Behavior Distance
Traveled, Circular Search Areas, and Initial Note. Select
“Access Forms”.
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Access Forms menu item
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Win C.A.S.I.E. III Initial Resources menu

Close “Access Forms”

and select “Urgency Rating Chart”.
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Urgency Rating Chart menu item

Notice “Clipboard”.
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Win C.A.S.I.E. III Initial Resources menu

Close “Urgency Rating Chart”

and select “Lost Person Behavior”.
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Lost Person Behavior menu item
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Win C.A.S.I.E. III Initial Resources menu

Close “Lost Person Behavior”

and select “Lost Person Behavior Distance Traveled”.
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Lost Person Behavior Distance Traveled menu item

Distances Traveled for Nine Categories of Lost Persons in
Nova Scotia, Canada

Category Cases 25% 50% 75% 90% Range Survived
(Median)

Children (1–6) 16 0.50 km 1.03 km 1.81 km 2.02 km 0.10–2.65 km 100%
0.31 mi 0.64 mi 1.12 mi 1.26 mi 0.06–1.65 mi

Children (7–12) 15 0.80 km 1.48 km 2.50 km 3.20 km 0.14–8.00 km 96%
0.50 mi 0.92 mi 1.55 mi 1.99 mi 0.09–4.97 mi

Youths (13–15) 23 0.86 km 1.49 km 3.00 km 4.18 km 0.40–7.00 km 100%
0.53 mi 0.93 mi 1.86 mi 2.60 mi 0.25–4.35 mi

Misc. Adults 49 0.75 km 1.70 km 3.57 km 7.82 km 0.10–19.00 km 98%
0.47 mi 1.06 mi 2.22 mi 4.86 mi 0.06–11.81 mi

Despondents 26 0.40 km 0.81 km 1.28 km 1.60 km 0.10–3.38 km 54%
0.25 mi 0.50 mi 0.80 mi 0.99 mi 0.06–2.10 mi

Dementia 41 0.40 km 1.00 km 1.46 km 2.40 km 0.10–5.43 km 73%
0.25 mi 0.62 mi 0.91 mi 1.49 mi 0.06–3.37 mi

Fishermen 38 0.92 km 1.77 km 4.15 km 6.01 km 0.45–17.70 km 91%
0.57 mi 1.10 mi 2.58 mi 3.73 mi 0.28–11.00 mi

Hikers 53 1.35 km 2.23 km 4.80 km 7.52 km 0.22–24.00 km 94%
0.84 mi 1.39 mi 2.98 mi 4.67 mi 0.14–14.91 mi

Hunters 127 1.30 km 2.39 km 3.83 km 8.00 km 0.10–19.31 km 94%
0.81 mi 1.49 mi 2.38 mi 4.97 mi 0.06–12.00 mi
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Win C.A.S.I.E. III Initial Resources menu

Close “Lost Person Behavior Distance Traveled”

and select “Circular Search Areas”.
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Circular Search Areas menu item

Notice “Clipboard”.
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Win C.A.S.I.E. III Initial Resources menu

Close “Circular Search Areas”.

The most important menu item is the Initial Note.
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Initial Note

A very simple text Editor, specifically tailored for SAR incidents.
“Help” menu item explains all.

Click on “File” menu item.
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Initial Note

A very simple text Editor, specifically tailored for SAR incidents.
“Help” menu item explains all. Click on “File” menu item.
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File menu item

Click on “Auto Save” menu item, then “Every 1 Minute”. Click
on “All Inserts At End”. Click on “Insert” menu item.
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File menu item

Click on “Auto Save” menu item, then “Every 1 Minute”.

Click
on “All Inserts At End”. Click on “Insert” menu item.
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File menu item
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Click on “Insert” menu item.
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File menu item

Click on “Auto Save” menu item, then “Every 1 Minute”. Click
on “All Inserts At End”. Click on “Insert” menu item.
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Insert menu item

Click on each of these templates in turn, to see what they
insert.

Notice text is always inserted at cursor position (at end).
To clear all text, press CTRL-A followed by Delete.

Aaron Dick, Eric Johnson, David Lovelock SAR Management Computer Software Intro



KwikNote
SARAZ.ORG

Using Win C.A.S.I.E. III During A Hasty Search
SAR T-Cards

Insert menu item

Click on each of these templates in turn, to see what they
insert. Notice text is always inserted at cursor position (at end).

To clear all text, press CTRL-A followed by Delete.
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Insert menu item

Click on each of these templates in turn, to see what they
insert. Notice text is always inserted at cursor position (at end).
To clear all text, press CTRL-A followed by Delete.
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Other menu items

Click on the templates
Add Resource
Subject Category
Clue
Found Subject
Team Status
Weather
Investigation
Message

Clear text between each one (press CTRL-A followed by
Delete).
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Note

Items saved to clipboard from the main Win C.A.S.I.E. III
menu,“Urgency Rating Chart” and “Circular Search Areas”, can
be pasted in the Initial Note (Ctrl-V).
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Note

The Initial Note is a text file that is saved to the Desktop as
“InitialNote.txt”. It can be loaded into any word processor and
edited.
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?

Any questions?
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Note

Delete “InitialNote.txt” from the Desktop, and do the
Win C.A.S.I.E. III assignments in ExercisesWC3.pdf. Make sure
you start on Card 1.
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Number Of SAR T-Cards

Open SAR T-Cards, either from the icon on the Desktop, or
from under “Help” in Win C.A.S.I.E. III.

When you see this, accept 200.
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What Are T-Cards?

T-Cards consist of two objects. A rack, containing lots of slots,
and color-coded index cards shaped like a T. The racks
columns are frequently thought of as "Checked In", "Assigned",
"Available", "Out Of Service", and "Checked Out". The cards fit
in the slots with just the top of the card showing. The color
determines the kind of resource. Purpose is to give a visual
state of the search.

In the typical ICS setting, there are seven kinds of resources:
Aircraft, Crew, Dozer, Engine, Helicopter, Miscellaneous, and
Personnel. Not SAR oriented!
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What Is SAR T-Cards?

SAR T-Cards is a program that tries to emulate physical
T-Cards.

It is always available, unlike physical T-Cards.
It is SAR oriented. In addition to the standard ICS cards, it
also has “ATV/Snowmobile”, “Command”, “Ground
Searcher”, “Ground Vehicle”, “Horse Patrol”, “K9”, and
“Water Searcher”.
SAR T-Cards for your SAR unit can be created ahead of
time, not in the heat of a search.
SAR T-Cards from visiting SAR units can be imported from
a thumbdrive as they arrive on scene.
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The Menu Items

Note, you can always get help in Help Topics under the Help
menu item.

Aaron Dick, Eric Johnson, David Lovelock SAR Management Computer Software Intro



KwikNote
SARAZ.ORG

Using Win C.A.S.I.E. III During A Hasty Search
SAR T-Cards

Resource File Menu

We can create a new resource file, open an existing one, or
convert a tab-delimited file to a resource file. Either way we can
add resources.
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Add New Resource

ID could be badge number, call sign, ... Qualifications and
Skills can be comma-separated.

Aaron Dick, Eric Johnson, David Lovelock SAR Management Computer Software Intro



KwikNote
SARAZ.ORG

Using Win C.A.S.I.E. III During A Hasty Search
SAR T-Cards

The Menu Items

Aaron Dick, Eric Johnson, David Lovelock SAR Management Computer Software Intro



KwikNote
SARAZ.ORG

Using Win C.A.S.I.E. III During A Hasty Search
SAR T-Cards

The File Menu

Aaron Dick, Eric Johnson, David Lovelock SAR Management Computer Software Intro



KwikNote
SARAZ.ORG

Using Win C.A.S.I.E. III During A Hasty Search
SAR T-Cards

After Opening Demo
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Mouse Hover
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Double Click on a resource T-Card to Edit
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The File Menu

More menu items are now exposed.
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Log

All card movements are recorded in a Log, which can be
searched, saved, and printed.
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Team Created
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Double Clicking on a Team T-Card
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Move Team T-Card to Out Of Service column
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After Disbanding Team
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The Reports Menu

Aaron Dick, Eric Johnson, David Lovelock SAR Management Computer Software Intro



KwikNote
SARAZ.ORG

Using Win C.A.S.I.E. III During A Hasty Search
SAR T-Cards

A Report
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?

Any questions?
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The File Menu

Select “Clear Resources”, and do the SAR T-Cards
assignments in ExercisesSARTCards.pdf. Make sure you start
on Card 1.
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Finally

Any questions?

Thank you.
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